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Disclaimer 

Dokumen ini disusun untuk keperluan internal Universitas Jenderal Soedirman. 
Dilarang untuk menyebarluaskan, mengedarkan kembali, menggunakan kembali dokumen        
ini di luar lingkungan Universitas Jenderal Soedirman tanpa seijin LPTSI Universitas           
Jenderal Soedirman. 
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Kata Pengantar 
 
Assalamu’alaikum Wr. Wb., 
Salam Sejahtera, 
 
Puji syukur kehadirat Allah SWT yang telah melimpahkan berkah dan          
rahmat-Nya hingga dokumen ​“Tips dan Trik G Suite for Education Unsoed           
bagi Mahasiswa”​ ini dapat tersusun. 
 

Sebagaimana telah kita ketahui bersama Universitas Jenderal Soedirman (Unsoed) telah          
menggunakan ​G Suite for Education dengan salah satu fitur terpentingnya berupa e-mail            
atau surat elektronik. Melalui pemanfaatan layanan ​G Suite for Education diharapkan email            
@student.unsoed.ac.id dapat meningkatkan kepercayaan sivitas akademika Unsoed       
khususnya mahasiswa dalam memanfaatkan layanan TIK Unsoed. Layanan TIK Unsoed          
berupa G Suite for Education memiliki berbagai macam fitur yang dapat digunakan pada             
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kegiatan pembelajaran mahasiswa, sehingga lebih mudah diakses tidak terbatas dimensi          
tempat dan waktu. 
 
Namun demikian, fitur ​G Suite for Education hingga saat ini masih belum optimal             
penggunaannya. Hal ini dapat dilihat dari tingkat ​login pengguna ​G Suite for Education             
Universitas Jenderal Soedirman yang masih rendah (33,58%). Dengan adanya         
permasalahan ini maka upaya untuk memanfaatkan email @student.unsoed.ac.id menjadi         
belum optimal. 
 
Dari beberapa diskusi yang dilakukan dengan beberapa pengguna, diketahui bahwa salah           
satu hambatan bagi pengguna untuk memanfaatkan email tersebut adalah belum          
tersosialisasinya petunjuk pemanfaatan fitur penting yang ada. Oleh karena itu dokumen ini            
diharapkan dapat mendorong mahasiswa Universitas Jenderal Soedirman untuk        
memanfaatkan email @student.unsoed.ac.id beserta fitur-fitur ​G Suite for Education yang          
melekat padanya secara lebih optimal. Selain itu, dokumen ini diharapkan dapat menjadi            
patokan materi sosialisasi pemanfaatan email @student.unsoed.ac.id serta ​G Suite for          
Education​ di Lingkungan Universitas Jenderal Soedirman. 
 
Sebagai sebuah proses, tentu saja kami sangat menyadari bahwa dokumen ini tak lepas             
dari banyak kekurangan. Namun demikian, semangat dan ikhtiar untuk mengantarkan          
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Unsoed semakin berkontribusi adalah menjadi ruh yang melandasi proses perubahan          
tersebut. Untuk itu, kami sangat mengharapkan masukan dari berbagai pihak demi           
perbaikan di masa yang akan datang. 
 
 
 

Ketua LPTSI Universitas Jenderal Soedirman 
 
 

Dr. Oedjijono, M.Sc 
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Latar Belakang 
 
Untuk memenuhi kebutuhan layanan email dan penyimpanan bagi civitas akademika          
Unsoed, LPTSI telah menerapkan penggunaan ​G Suite for Education di Unsoed. Beberapa            
layanan penting yang dapat digunakan untuk meningkatkan produktivitas Unsoed secara          
keseluruhan antara lain: Google e-Mail, Google Calendar, Google Drive, Google Docs,           
Google Sheets, Google Slides, dan Google Forms serta Google Meet. Penggunaan           
aplikasi-aplikasi tersebut perlu didorong agar dapat digunakan secara lebih optimal. Untuk           
membantu pengguna ​G Suite for Education di Universitas Jenderal Soedirman, maka perlu            
disusun tips dan trik penting aplikasi ​G Suite for Education​. 
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Mengapa menggunakan Identitas TIK Unsoed 
@student.unsoed.ac.id dan G Suite for 
Education? 
 

1. Meningkatkan branding Universitas Jenderal Soedirman di mata publik. 
2. Dengan menggunakan fasilitas G Suite for Education, email @student.unsoed.ac.id         

memiliki kehandalan sebaik email Google sebagai salah satu penyedia layanan          
email terbaik. 

3. Pengguna G Suite for Education mendapatkan kapasitas penyimpanan hingga 5TB.          
Kapasitas ini jauh lebih besar dibandingkan dengan layanan email institusi          
sebelumnya (90MB) maupun layanan Google gratis (15GB). 

4. Terdapat produk-produk G Suite handal yang dapat digunakan : 
a. Untuk berkomunikasi seperti: email, meet, calendar, 
b. Drive untuk menyimpan berkas, mahasiswa memiliki media penyimpanan        

yang aman untuk data perkuliahan, penelitian dan tugas akhir, sehingga          
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meminimalisir permasalahan yang menghambat perkuliahan hingga      
kelulusan. 

c. G Docs, Sheets, Slides serta Forms untuk berkolaborasi. Dosen dan          
mahasiswa dapat bersama-sama mengamati progres sebuah dokumen misal        
skripsi, sehingga akuntabilitas  dan kelulusan tepat waktu dapat tercapai. 

d. Google Classroom menjadi sarana yang memadukan fasilitas inti G Suite          
(Drive, Form, Office) sebagai media pembelajaran yang terbatas jarak dan          
waktu. 
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Keamanan dasar 
 
Untuk menjaga keamanan akun G Suite for Education Universitas Jenderal Soedirman           
anda, lakukanlah beberapa tip berikut. 

1. Jangan pernah menyerahkan password anda kepada orang lain. Admin sistem          
informasi Universitas Jenderal Soedirman tidak pernah meminta password anda. 

2. Jangan menuliskan password anda di tempat yang mudah diketahui orang lain. 
3. Jangan menggunakan pola password yang mudah ditebak. 
4. Gantilah password anda secara berkala. 
5. Aktifkan two step verification pada akun anda. 
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Pengetahuan Dasar 
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Login ke G Suite for Education Universitas Jenderal Soedirman 
 

Untuk dapat menggunakan fasilitas ​G Suite for       
Education Universitas Jenderal Soedirman, anda harus      
terdaftar melalui Sihura. Silahkan menghubungi operator      
Sihura di masing-masing unit kerja. Adapun      
langkah-langkah untuk login adalah sebagai berikut. 

1. Membuka laman: mail.unsoed.ac.id sebagaimana    
ditunjukkan pada gambar berikut. 

2. Memasukkan akun pengguna sistem informasi     
Universitas Jenderal Soedirman. 

3. Tekan “Berikutnya”. 
4. Memasukkan password pengguna sistem    

informasi Universitas Jenderal Soedirman. 
5. Tekan “Berikutnya”. 
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Menambahkan akun G Suite ke perangkat android 
 
Perangkat android dapat menggunakan lebih dari satu akun Google. Untuk menambahkan           
akun ​G Suite for Education Universitas Jenderal Soedirman lakukanlah langkah-langkah          
berikut. 

1. Bukalah settingan akun pada perangkat anda: account settings. 
2. Tambahkan akun ​G Suite anda dan ikuti instruksi hingga selesai. Setelah selesai            

anda akan melihat pesan yang menyatakan: “​Account sign-in successful​". 
3. Pilihlah produk apa saja yang ingin anda sinkronisasi dengan perangkat anda.           

Beberapa produk yang penting untuk anda sinkronisasi adalah sebagai berikut. 
a. Gmail 
b. Contact 
c. Calendar 
d. Drive 

4. Ulangi langkah tersebut di atas jika anda ingin menambahkan akun lainnya. 
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Menggunakan berbagai produk G Suite 
 
Ada dua cara untuk beralih ke berbagai produk G Suite sebagai berikut. 
 

1. Pada pojok kanan atas laman Google pilihkan ikon        
Google Apps dan pilihlah produk G Suite yang akan         
anda gunakan. 

 
2. Masukkan alamat produk G Suite yang akan anda gunakan pada bilah alamat            

peramban anda. Sebagai contoh: 
a. mail.google.com 
b. drive.google.com 
c. calendar.google.com 
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Menambahkan aplikasi G Suite ke dalam perangkat android 
 

Salah satu keuntungan penggunaan G Suite for Education adalah         
kemudahan penggunaannya pada perangkat android. Untuk      
menggunakan produk-produk G Suite for Education pada perangkat        
bergerak android anda, anda perlu memastikan aplikasi-aplikasi       
berikut terpasang pada perangkat android anda melalui aplikasi Play         
Store. 
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Mengganti password akun G Suite for Education 
 
Mengganti password layangan G Suite for Education Universitas Jenderal Soedirman          
dilakukan melalui aplikasi sihura. 

1. Masuk ke laman sihura.unsoed.ac.id. 
2. Pilih menu ganti password. 
3. Ganti password dengan aturan sebagai berikut. 

a. Minimal 8 karakter. 
b. Merupakan kombinasi huruf kapital, huruf kecil, angka dan simbol 

4. Password baru dapat digunakan paling lama 30 menit setelah penggantian password           
di aplikasi sihura. 

5. Jika ada permasalahan dalam penggantian password silahkan menghubungi        
operator sihura fakultas di bagian kepegawaian fakultas atau operator sihura          
universitas di bagian kepegawaian universitas. 
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Google Mail 
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Login lebih dari 1 alamat email Google di PC 
 
Jika anda sudah memiliki akun Google sebelum memiliki akun G Suite for Education             
Universitas Jenderal Soedirman maka anda dapat melakukan login pada akun-akun anda           
tersebut secara bersamaan. Untuk melakukan hal tersebut, anda dapat mengikuti          
langkah-langkah berikut. 

1. Tekanlah icon akun anda di bagian kanan atas. 
2. Pilihlah “Add account”. 
3. Masukkan username anda. 
4. Masukkan password anda. 
5. Peramban anda akan membuka tab baru yang membawa anda pada akun G Suite             

anda yang baru saja login. Akun G suite anda yang sebelumnya akan tetap berada              
pada tab sebelumnya. 
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Login lebih dari 1 alamat email di perangkat android 
Dengan menambahkan lebih dari satu akun G Suite pada perangkat android dan            
memastikan sinkronisasi emailnya, maka anda akan dapat mengakses email lebih dari satu            
akun pada satu perangkat android. Untuk memilih akun email mana yang akan anda akses,              
ketuklah ikon akun pada bagian kanan atas aplikasi email di perangkat android anda. Anda              
akan dihadapkan pada menu pilihan akun yang akan anda tampilkan. Pilihlah akun yang             
akan anda tampilkan.  
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Menambahkan signature pada email 
Anda dapat menambahkan signature pada setiap email anda. 
Untuk menambahkah signature pada email yang anda kirim dari desktop ikuti           
langkah-langkah berikut. 

1. Masuk ke email anda. Pada bagian kanan atas tekan icon setting yang berupa roda              
gigi, pilih “Settings”. 

2. Pada bagian “Signature” tambahkan signature anda pada box yang tersedia. Anda           
dapat memformat tampilan signature yang anda buat maupun menambahkan         
gambar. Selanjutnya tekan “Save change”. 

Untuk menambahkan signature pada email yang anda kirim melalui perangkat android anda,            
ikuti langkah-langkah berikut. 

1. Masuk ke dalam aplikasi email anda. Tekan menu tiga garis bertumpuk di kiri atas. 
2. Pilih “Setting”, pilih akun yang akan anda atur. 
3. Ubahlah signature anda pada bagian “Mobile Signature”.  

LPTSI Unsoed 2020 Halaman ​23 



Menggunakan fasilitas delegate email 
Ketika anda mengelola alamat email institusi maka anda dapat mendelegasikan penerimaan           
dan pengiriman email kepada beberapa orang dalam organisasi anda. Setiap email yang            
dikirim dari akun yang menerima delegasi akan mendapatkan keterangan tambahan akun           
pengirim yang sesungguhnya. Hal ini akan memudahkan untuk melacak alur informasi. 

1. Masuk ke email anda. Pada bagian kanan atas tekan icon setting yang berupa roda              
gigi, pilih “Settings”. 

2. Pilih bagian “Accounts”. 
3. Tambahkan akun yang akan anda beri delegasi pada bagian: “Grant access to your             

account”. 
4. Akun yang anda beri delegasi harus menerima delegasi yang anda berikan. 

  

LPTSI Unsoed 2020 Halaman ​24 



Menggunakan mode konfidensial pada email yang anda kirim 
Anda dapat menggunakan mode konfidensial pada email anda untuk mencegah penerima           
email anda meneruskan, menyalin, mencetak ataupun mengunduh email anda. Untuk          

melakukannya pada saat anda membuat email tekanlah tombol “Turn confidential mode            
on / off” di bagian bawah tampilan pembuatan email. Selanjutnya anda dapat menentukan             
waktu kadaluarsa email anda maupun menyetel passcode untuk membuka email anda. 
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Google Drive 
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Menggunakan Shared Drives 
Salah satu fitur G Suite for Education yang tidak ditemui pada aplikasi Google biasa adalah               
Shared Drives. Beberapa keunggulan shared drives adalah sebagai berikut. 

1. Kapasitas penyimpanan anda tidak akan terpotong oleh berkas yang digunakan          
bersama-saman. 

2. Ketika seorang anggota tim meninggalkan tim maka berkas yang diunggah oleh yang            
bersangkutan akan tetap dapat diakses oleh anggota tim yang lainnya. 

Untuk menggunakan Shared Drives ikutilah langkah-langkah berikut ini. 
1. Bukalah laman drive.google.com, pilihlah menu Shared Drives di bagian kiri. 
2. Buatlah folder Shared Drives baru anda. 
3. Selanjutnya pilihlah Shared Drives yang baru anda buat. 
4. Pilihlah menu “Add members” pada nama shared drives anda, masukkan anggota           

tim yang anda kehendaki. 
5. Anda dapat memberikan hak akses yang berbeda-beda kepada setiap anggota tim.  
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Tips penting penyetelan Shared Drives 
Anda dapat mengatur bagaimana    
shared drives yang anda buat     
diakses dengan memilih menu    
“Shared Drives Settings”.   
Pengaturan yang dapat anda    
lakukan adalah sebagai berikut. 
1. Memberikan akses berkas   

kepada orang di luar organisasi     
Universitas Jenderal Soedirman. 

2. Memberikan akses berkas   
kepada orang di luar anggota     
tim. 

3. Pengaturan unduh, salin dan    
cetak berkas pada Shared    
Drives.  
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Menggunakan perangkat android untuk memindai berkas      
menjadi berkas PDF 
Seringkali anda harus membuat berkas PDF dari salinan tercetak sebuah dokumen.           
Biasanya hal tersebut anda lakukan dengan menggunakan scanner. Anda dapat membuat           
berkas PDF dari salinan tercetak dengan menggunakan perangkat android anda. Ikuti           
langkah-langkah berikut. 

1. Buka aplikasi Google Drive pada perangkat android anda. 
2. Tekan simbol + untuk membuat dokumen baru. 
3. Pilihlah Scan 
4. Anda dapat memotret salinan tercetak menggunakan kamera pada perangkat         

android anda. Setelah selesai memotret anda dapat menyunting gambar yang          
dihasilkan (baik memangkas maupun memutar gambar). 

5. Anda dapat menambahkan halaman lain. 
6. Setelah selesai anda dapat menyimpan berkas PDF anda di Google Drive.  
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Google Docs 
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Menggunakan Google Docs untuk berkolaborasi membuat      
dokumen 

Sering kali anda harus membuat dokumen bersama       
dengan tim. Jika anda membagikan dokumen melalui       
email kepada setiap anggota tim dan anggota tim        
menyunting dokumen tersebut, maka akan terjadi      
kesulitan dalam mengkolaborasikan hasil suntingan     
setiap anggota tim. Dengan membagikan akses      
dokumen kepada anggota tim anda, maka setiap       
anggota tim dapat menyunting dokumen yang sama,       
sehingga kolaborasi dokumen dapat dilakukan dengan      
lebih mudah. Untuk membagikan dokumen dengan      

menekan tombol “Share” kemudian memasukkan alamat email setiap anggota tim anda.           
Anda dapat menentukan hak akses setiap anggota tim yang meliputi: “Edit”, “Comment” dan             
“View”. 
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Melihat versi dokumen terdahulu pada Google Docs 
Sering kali pada saat menyunting dokumen anda ingin        
melihat kembali versi terdahulu. Salah satu fitur penting        
dari G Suite dalan melihat kembali versi-versi terdahulu        
dari dokumen yang anda sunting. Untuk melihat versi        
terdahulu, anda dapat menekan menu: “All changes       
saved in Drive”. Selain itu anda dapat memilih menu: “File          
→ Versions history → See version history” atau menekan         
tombol “Ctrl+Alt+Shift+H” secara bersamaan. 
Dengan menekan tiga titik di sebelah kanan versi        
terdahulu, anda dapat memberi nama versi terdahulu       
tersebut maupun membuat salinan dari versi terdahulu       
tersebut. 
Anda juga dapat memulihkan versi terdahulu tersebut       
dengan memilih menu “Restore this version”.  
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Menyisipkan daftar isi pada Google Docs 
Daftar ini merupakan salah satu komponen penting dalam dokumen. Untuk menyisipkan           
daftar isi pada dokumen yang anda buat dengan menggunakan Google Docs lakukanlah            
langkah-langkah berikut. 

1. Pastikan dokumen anda dibuat dengan menggunakan outline yang jelas         
memanfaatkan format heading yang ada. 

2. Letakkan kursor anda pada lokasi di mana anda ingin meletakkan daftar isi. 
3. Pilihlah menu: Insert → Table of Contents 
4. Anda dapat memilih dua tipe daftar isi: 

a. daftar isi dengan nomor halaman, atau 
b. daftar isi dengan link.  
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Menampilkan outline dokumen pada Google Docs 
Outline dokumen dapat membantu kita dalam      
menyunting maupun membaca dokumen pada     
Google Docs. Sebelum menampilkan outline     
dokumen pastikan dokumen yang anda buat      
menggunakan format heading yang ada untuk judul       
bab maupun subbab-nya. 
Untuk menampilkan outline dokumen anda dapat      
melakukannya dengan dua cara sebagai berikut. 
1. Menekan tombol “Ctrl+Alt+A” kemudian tanpa     

melepas tombol Ctrl dan Alt dilanjutkan      
menekan “Ctrl+Alt+H”. 

2. Memilih menu: View → Show Document      
Outline.  
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Menyisipkan sitasi dan menambahkan daftar pustaka pada       
Google Docs 
Anda dapat memanfaatkan zotero untuk menyisipkan sitasi dan menambahkan daftar          
pustaka pada dokumen anda. Untuk melakukannya ikutilah langkah-langkah berikut. 

1. Bukalah aplikasi zotero anda. 
2. Login pada aplikasi zotero yang terkait dengan akun G Suite anda. 
3. Sisipkan sitasi dengan memilih menu: “Zotero → Add/edit Citation” atau menekan           

tombol “Ctrl+Alt+C” secara bersamaan. Anda akan dibawa tampilan untuk memilih          
pustaka yang akan disitasi. 

4. Untuk menambahkan daftar pustaka, letakkan kursor pada lokasi yang anda          
inginkan, pilih menu: “Zotero → Add/edit Bibliography” 

5. Untuk mengatur model penulisan sitasi dan daftar pustaka anda dapat memilih           
menu: “Zotero → Document Preferences”  
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Membuat berkas PDF dari Google Docs 
Untuk mendapatkan berkas PDF dari dokumen yang anda kerjakan, pilihlah menu: 
“File →Download as → PDF Document (.pdf)” 
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Menambahkan foto pada dokumen menggunakan perangkat      
android 

1. Buka aplikasi Google Drive atau Google Docs pada perangkat android anda. 
2. Pilihlah berkas dokumen yang akan anda sisipi foto. 
3. Tekan icon pensil di pojok kanan bawah untuk menyunting dokumen. 
4. Mulai menyisipkan foto. 

a. Letakkan kursor pada tempat anda akan menyisipkan foto. 
b. Pilih ikon “+” , pilih “Image”, pilih “From camera”. 
c. Ambil gambar dengan menggunakan kamera anda. 
d. Ulangi langkah diatas hingga anda selesai menyisipkan foto yang anda          

inginkan. 
5. Tekan ikon centang di bagian kiri atas untuk menyimpan dokumen yang telah selesai             

anda sunting.  
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Google Sheets 
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Membuat pivot table pada Google Sheet 
1. Di komputer, buka sebuah spreadsheet di​ ​Google Sheets​. 
2. Pilih sel dengan sumber data yang ingin digunakan. ​Catatan: setiap kolom harus            

mempunyai header. 
3. Pada menu di atas, klik ​Data > ​Pivot table​. Klik pada sheet pivot table, jika belum                

terbuka. 
4. Di panel samping, di sebelah "Rows" atau "Columns," click ​Add​, kemudian pilih            

value. 
○ Catatan: Terkadang, anda akan melihat rekomendasi pivot tables        

berdasarkan data yang anda pilih. Untuk menambah pivot table, di bawah           
"Suggested," pilih sebuah pivot table. 

5. Di panel samping, di samping "Values," klik ​Add​, kemudian pilih nilai yang ingin anda              
lihat pada baris dan kolom. 

6. Anda dapat mengubah tampilan data, mengurutkan, membuat summary atau         
membuat filter. Di sebelah sel yang ingin diubah, klik panah ke bawah. 
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Membuat grafik pada Google Sheet 
1. Di komputer, buka sebuah spreadsheet di​ ​Google Sheets​. 
2. Pilih sel yang akan dimasukkan ke dalam grafik. 
3. Klik ​Insert​ > ​Chart​. 
4. Untuk mengubah grafik, double klik pada grafik. 
5. Di menu yang muncul, pilih ​Setup dan grafik bisa dimodifikasi. Misal jenis grafik bisa              

diganti jadi grafik batang, diagram lingkaran atau yang lainnya. 
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Google Slides 
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Membuat presentasi menggunakan Google Slides 
Membuat presentasi baru 

1. Buka laman Slide di ​slides.google.com​. 
2. Di kiri atas, di bawah "Start a new presentation," click New +. Hal ini akan membuat                

dan membuka presentasi baru Anda. 

Anda juga dapat membuat presentasi baru di alamat:​ ​https://slides.google.com/create​. 
 
Mengedit dan mengubah format sebuah presentasi 
Anda dapat menambahkan, mengedit, atau memformat teks, gambar, atau video dalam           
presentasi. 

● Memasukkan dan mengatur teks, bentuk, dan garis 
● Menambah, menghapus dan mengatur slide 
● Menambah animasi ke dalam slide. 
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Google Forms 
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Menggunakan Google Form untuk membuat kuesioner 
1. Bukalah laman: ​https://docs.google.com/forms/​ dan klik “Blank”. 
2. Beri nama kuesioner yang akan dibuat di “Untitled form”. 
3. Klik di “Untitled Question” dan tulislah pertanyaan. 
4. Pilih tipe jawaban, misal “Multiple choice”. 
5. Ikon menu  di samping digunakan untuk: 

a. Plus: menambah pertanyaan lain, 
b. Tt: menambah judul section dan deskripsi, 
c. Photo dan Video: menambahkan ilustrasi kuesioner, 
d. Dua kotak: memecah kuesioner menjadi beberapa bagian. 

6. Klik tanda “Required” untuk membuat pertanyaan wajib dijawab oleh pengisi          
kuesioner. 

7. Ulangi langkah 3 - 6 sesuai kebutuhan jumlah pertanyaan. 
8. Respon pengisi yang akan diolah lebih lanjut dapat disimpan ke dalam Sheet.            

Pengaturan ada di bagian “Responses”.  
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Menggunakan Google Form untuk mengumpulkan berkas      
digital 
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Menggunakan Google Form untuk membuat ujian online 
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Google Calendar 
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Menambahkan Google Calendar ke dalam perangkat android 
 
Anda dapat menambahkan kalender dari akun G Suite for Education anda ke dalam             
perangkat android anda. Hal ini memungkinkan anda untuk mendapatkan notifikasi terkait           
dengan jadwal kegiatan anda langsung pada perangkat android anda. Untuk          
menambahkannya anda cukup menambahkan akun G Suite ke perangkat android anda dan            
mengaktifkan sinkronisasi kalender. 
Ada kalanya perangkat android yang anda miliki telah menggunakan aplikasi kalender           
tersendiri dan tidak menggunakan aplikasi kalender dari Google. Hal ini sering kali            
mengakibatkan permasalahan ketika melakukan sinkronisasi kalender. Untuk mengatasi hal         
tersebut anda dapat memasang aplikasi Google Calendar melalui Play Store. 
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Membuat undangan rapat dengan menggunakan Google      
Calendar 

1. Masuklah ke calendar.google.com menggunakan peramban anda. 
2. Pilih menu “Create”, akan muncul popup menu untuk menambahkan kegiatan pada           

calendar. Pilihlah “More options” di bagian bawah. 
3. Anda dapat menyunting judul kegiatan serta menentukan waktu kegiatan. 
4. Pada bagian “Add description” anda dapat menambahkan deskripsi kegiatan         

maupun menambahkan lampiran berkas baik dari komputer anda maupun dari          
Google Drive. 

5. Anda dapat mengundang orang lain dalam rapat pada bagian “Guest”. 
6. Anda dapat mencari waktu kosong dari setiap orang yang anda undang dengan            

memilih bagian “Find a Time”. 
7. Setelah selesai anda dapat menekan tombol save dan pilihlah send invitation email            

agar setiap orang yang anda undang mendapatkan email notifikasi. 
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Menerima undangan rapat pada Google Calendar 
Ada dua cara yang dapat anda lakukan untuk menerima undangan rapat pada Google             
Calendar. 

1. Melalui email notifikasi yang dikirimkan oleh orang yang mengundang anda. 
2. Melalui laman calendar.google.com anda. 

Anda memiliki tiga alternatif respon undangan yang diberikan kepada anda. Ketiga alternatif            
tersebut adalah: “Yes”, “Maybe” atau “No”. Anda juga dapat memberikan catatan kepada            
pengundang anda. 
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Calendar create cheat sheet 
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Calendar event cheat sheet 
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Isu keamanan Calendar 
 

 

LPTSI Unsoed 2020 Halaman ​53 



Google Meet 
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Melakukan konferensi video menggunakan Google Meet pada       
perangkat Android 

1. Pastikan aplikasi ​Meet​ terpasang pada perangkat android anda. 
2. Jika anda akan memulai konferensi lakukanlah langkah berikut. 

a. Buka aplikasi Meet, tekan simbol ​“+ New meeting​”.  
b. Anda dapat mengundang rekan anda menggunakan tombol “Share” dan         

mengirimkan kode konferensi yang anda buat kepada rekan anda. Kode          
konferensi ini dapat anda bagikan melalui media sosial maupun email atau           
media lainnya yang mungkin. 

3. Jika akan akan bergabung dengan konferensi dari rekan anda. 
a. Buka aplikasi Meet. 
b. Pilih “​Meeting code​” dan masukkan kode konferensi yang akan anda ikuti. 

4. Setelah anda masuk ke dalam suatu konferensi, kode konferensi dapat anda lihat            
kembali dengan menekan menu info dari konferensi. 
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Melakukan konferensi video menggunakan ​Google Meet pada       
komputer desktop 
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Login Ke Google Meet 
1. Masuk ke laman meet.google.com menggunakan peramban anda. 
2. Jika anda belum login ke ​Google Meet​, masuklah ke ​Google Meet menggunakan            

akun ​Google Suite Unsoed anda dengan menekan tombol “​Sign in​” di bagian kanan             
atas. 
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Bergabung atau memulai sebuah konferensi  
1. Tekanlah tombol “​Join or start meeting​”. 
2. Jika anda akan bergabung dengan sebuah konferensi masukkan kode konferensi          

(masukkan kodenya tanpa simbol “-”, misal “wnhuhywham”). 
3. Jika anda akan akan memulai sebuah konferensi, masukkan nickname yang akan           

gunakan atau biarkan kosong 
4. Tekan tombol “​Continue​”, ikuti petunjuk selanjutnya untuk memberikan izin kepada          

peramban mengakses microphone dan kamera anda. Selanjutnya tekan tombol “​Join          
now​”. 
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Mempresentasikan materi 
1. Jika anda ingin mempresentasikan suatu materi kepada peserta konferensi anda,          

tekan tombol “​Present now​”. 
2. Pilih “​Your entire screen​” jika anda ingin mempresentasikan seluruh tampilan layar           

anda atau pilih ​“A window​” jika anda hanya ingin mempresentasikan sebuah jendela            
saja. 
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Membagikan kode konferensi kepada pengguna lain 
1. Tekan “​Meeting details​” di bagian kiri bawah. 
2. Selanjutnya tekan “​Copy joining info​” pada ​pop up​ yang muncul. 
3. Informasi tersebut dapat anda tempelkan untuk dikirimkan ke calon peserta lain. 
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Menambahkan konferensi pada penjadwalan ​Calendar 
1. Buatlah event pada ​Google Calendar​. 
2. Tentukan waktu konferensi. 
3. Tambahkan peserta dengan   

menambahkan pada bagian “​Add    
guests​”. 

4. Pada bagian “ ​Add conferencing​”     
pilihlah “​Hangout Meets​”, terdapat kode     
konferensi yang akan digunakan. 

5. Simpan jadwal. 
6. Anda dapat mengirimkan notifikasi    

kepada para peserta yang anda     
undang. 
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Google Classroom 
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Mengikuti sebuah kelas 

Terima kode kelas dari dosen terlebih dahulu, lalu ikuti langkah berikut : 

1. Buka ​classroom.google.com​. 
2. Di bagian atas, klik Tambah (+)      

> Gabung ke kelas. 
3. Masukkan kode kelas yang    

diberikan oleh pengajar, lalu klik     
Gabung. 

4. Kode kelas terdiri dari 6 atau 7       
huruf atau angka. Misalnya, hjhmgrk atau g5gdp1. 

Masuk ke dalam kelas dapat dilakukan pula dengan adanya undangan dari dosen : 

1. Buka ​classroom.google.com​. 
2. Pada kartu kelas, klik Gabung. 
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Melihat tugas di dalam kelas 

Melihat tugas mendatang dengan cepat 
Di halaman Kelas, pada kartu kelas, Anda dapat melihat tugas                   
yang harus dikumpulkan dalam waktu satu minggu. Anda akan                 
melihat judul dan batas waktu untuk maksimum 3 item. 

1. Buka ​classroom.google.com​. 
2. (Opsional) Untuk melihat detailnya, klik judul tugas. 

Melihat semua tugas untuk kelas 
Anda dapat melihat daftar semua tugas di halaman Tugas Anda. Anda dapat memeriksa nilai,                           
meninjau tugas dan batas waktu, serta melihat tugas yang terlambat atau tidak dikerjakan. Anda                           
juga dapat memfilter tugas berdasarkan status: Ditugaskan, Dikembalikan dengan nilai, atau                     
Tidak dikerjakan. Anda dapat melihat detail lainnya, seperti komentar atau lampiran jika                       
diinginkan. 

1. Buka ​classroom.google.com​. 
2. Pilih opsi: 
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a. Pada kartu kelas, klik       

Tugas Anda . 

b. Klik kelas Tugas       

Kelas Lihat tugas       
Anda. 
 

3. (Opsional) Agar dapat melihat       
lampiran, komentar, atau     
detail lainnya untuk tugas atau         

pertanyaan, klik judul tugas  Lihat detail. 
4. (Opsional) Untuk memfilter tugas, pada Filter, klik Ditugaskan, Dikembalikan dengan nilai,                     

atau Tidak dikerjakan. 

Memfilter tugas berdasarkan kelas 
Di halaman Daftar Tugas, Anda dapat memfilter tugas berdasarkan kelas, dan melihat tugas                         
yang: 
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● Perlu diselesaikan—Tugas yang diberikan dan belum selesai. Anda akan melihat kelas                     
dan judul tugas yang dikelompokkan sebagai tidak dikerjakan, tidak ada batas waktu,                       
batas waktu hari ini atau dalam seminggu, atau di lain waktu. 

● Selesai—Tugas yang telah diselesaikan dan diserahkan. Anda akan melihat status                   
tugas—diserahkan atau selesai terlambat—dan nilai jika tugas telah diberi nilai. 

Untuk melihat tugas: 

1. Buka ​classroom.google.com​. 

2. Klik Menu  Daftar tugas. 
3. (Opsional) Untuk memfilter tugas       

berdasarkan kelas, klik Semua kelas, lalu pilih             
kelas. 

4. Klik judul. 
5. (Opsional) Untuk melihat tugas yang sudah           

dikirimkan, klik Selesai, lalu pilih judul untuk             
melihat masukan. Jika tugas telah diberi nilai, nilai akan dicantumkan dalam halaman. 

Melihat tugas yang disusun berdasarkan topik 
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Pengajar mungkin menyusun tugas berdasarkan topik, seperti pekerjaan rumah atau esai, di                       
halaman Tugas Kelas. 

1. Buka ​classroom.google.com​. 
2. Klik kelas. 
3. Di bagian atas, klik Tugas Kelas. 

4. Pada topik, cari Pertanyaan  atau Tugas . 

5. (Opsional) Untuk melihat petunjuk atau masukan, klik postingan Lihat tugas atau Lihat                         
pertanyaan. 

Menyerahkan tugas 
1. Buka ​classroom.google.com​. 

2. Klik kelas Tugas Kelas tugas. 
3. Untuk melampirkan item: 

● Pada Tugas Anda, klik Tambahkan atau buat pilih             

Google Drive , Link , atau File . 
● Pilih lampiran atau masukkan URL untuk link, lalu klik                 

Tambahkan. 
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Catatan: Anda tidak dapat melampirkan file yang tidak Anda miliki. 
4. Untuk melampirkan dokumen baru: 

● Pada Tugas Anda, klik Tambahkan atau buat pilih Dokumen , Slide ,                     

Spreadsheet , atau Gambar . 
File baru akan dilampirkan ke tugas Anda dan terbuka. 

● Klik file tersebut dan masukkan informasi Anda. Catatan: Anda dapat                   
melampirkan atau membuat lebih dari satu file. 

5. (Opsional) Untuk menghapus lampiran, klik         

Hapus di samping nama lampiran. 
6. (Opsional) Untuk mengirimkan komentar       

pribadi kepada pengajar, pada Komentar         
pribadi, masukkan komentar, lalu klik Posting           

. 
7. Klik Serahkan dan konfirmasikan. 

Status tugas akan berubah menjadi         
Diserahkan. 
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Menyerahkan tugas kuis 
1. Buka ​classroom.google.com​. 

2. Klik kelas Tugas Kelas tugas. 
3. Klik formulir dan jawab pertanyaannya. 

4. Klik Kirim Tandai sebagai selesai, lalu konfirmasi. Jika formulir tersebut adalah                   
satu-satunya tugas yang harus dikerjakan, status tugas akan berubah menjadi                   
Diserahkan. 

5. (Optional) Jika ada tugas lain yang harus dikerjakan, klik Buka tugas. 

Menyerahkan tugas dengan dokumen yang ditugaskan kepada Anda 

Jika pengajar melampirkan dokumen dengan nama Anda dalam judul, dokumen tersebut adalah                       
salinan pribadi Anda untuk ditinjau dan diedit. Saat mengerjakannya, pengajar dapat meninjau                       
kemajuan Anda sebelum Anda mengklik Serahkan.  

1. Buka ​classroom.google.com​. 

2. Klik kelas Tugas Kelas tugas. 
3. Untuk membuka file yang ditugaskan, klik thumbnail yang mencantumkan nama Anda.  
4. Masukkan tugas Anda. 
5. Pilih salah satu: 
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● Di dokumen, klik Serahkan, lalu konfirmasikan.  
● Di Classroom, pada tugas, klik Serahkan , lalu konfirmasikan, ​Status tugas akan                       

berubah menjadi Diserahkan. 

Membatalkan pengiriman tugas 
Penting: Setiap tugas yang diserahkan atau ditandai selesai setelah batas waktunya akan                       
ditandai terlambat, meskipun Anda sebelumnya telah mengirimkan tugas tersebut sebelum                   
batas waktu. Jika Anda membatalkan pengiriman tugas, pastikan untuk mengirimkannya                   
kembali sebelum batas waktu. 

1. Buka ​classroom.google.com​. 

2. Klik kelas Tugas Kelas tugas. 
3. Klik Batalkan pengiriman dan       

konfirmasikan. Catatan: Tugas ini telah         
dibatalkan pengirimannya. Kirim ulang       
tugas sebelum batas waktu. 

Memeriksa tugas yang terlambat diserahkan atau tidak diserahkan 
Pengajar menetapkan kebijakan untuk tugas yang terlambat diserahkan bagi kelas Anda. Namun,                       
Classroom tidak dapat mencegah Anda menyerahkan tugas yang terlambat.  
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Saat pengajar memberikan tugas, tugas akan ditandai sebagai Ditugaskan. Jika Anda tidak                       
menyerahkan tugas tepat waktu, tugas akan ditandai sebagai Tidak diserahkan atau Terlambat                       
diselesaikan segera setelah batas tanggal atau batas waktu tiba. Misalnya, jika batas akhir                         
pengumpulan tugas adalah pukul 09.00, serahkan sebelum pukul 08.59. Jika Anda                     
menyerahkannya pada pukul 09.00, tugas akan dianggap terlambat. 

1. Buka ​classroom.google.com​. 

2. Pada kartu kelas, klik Tugas Anda . 
3. Di sebelah kanan, Anda dapat melihat status pengerjaan setiap item: 

● Ditugaskan—Tugas yang diberikan oleh pengajar Anda. Periksa batas waktu. 
● Diserahkan—Tugas yang diserahkan tepat waktu. 
● Dinilai—Untuk tugas yang telah dinilai yang dikembalikan oleh pengajar, Anda                   

akan melihat nilai Anda. 
● Dikembalikan—Untuk tugas yang tidak dinilai yang dikembalikan oleh pengajar,                 

Anda akan melihat tanda centang . 
● Tidak diserahkan—Tugas yang tidak diserahkan. 
● Diserahkan: Terlambat diselesaikan—Tugas yang terlambat diserahkan.   

4. (Opsional) Untuk detail selengkapnya, klik item untuk meluaskannya klik Lihat detail. 
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Membuat postingan forum 
Untuk mengajukan pertanyaan atau berbagi informasi dengan pengajar dan teman sekelas, buat 
postingan.  

1. Buka ​classroom.google.com​. 
2. Klik kelas. 
3. Di halaman Forum, klik Bagikan sesuatu           

dengan kelas Anda. Catatan: Jika Anda tidak             
melihat Bagikan sesuatu dengan kelas Anda,           
berarti pengajar menonaktifkan izin untuk         
memposting. 

4. Ketik yang ingin dikatakan, lalu klik Posting. 
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Bantuan Lebih Lanjut 
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Help Desk LPTSI 
Alamat 
Gedung LPTSI Universitas Jenderal Soedirman 
Prof. dr. HR. Boenjamin No. 708, 
Kotak Pos 115, Purwokerto, 53122 
Telepon 
(+62) 281 635292 (hunting) Ext. 136, 
(+62) 281 625228 
Fax 
(+62) 281 631802 
e-mail 
lptsi@unsoed.ac.id 
 
 
Melayani adalah Panggilan Hati…. 
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G Suite Learning Center 
 
https://gsuite.google.com/learning-center/#!/ 
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